
SOCET GXP® v3.0
User interface
SOCET GXP v3.0 features an updated look and feel based on the Microsoft® 
Office Fluent™ user interface. The new user interface — the way it looks, the 
way it’s organized, and the way users interact with it — is designed to simplify 
workflows and make the software easy to use for every kind of task.

This white paper examines the reasons for implementing a new user interface 
and introduces some of its key features.
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Why does SOCET GXP v3.0 have a new 
user interface?
Before reviewing the details of the new user interface, it is important to 
understand why it has changed and the goals for adopting it.

The main reason for updating the SOCET GXP v3.0 user interface was to 
take advantage of a new design Microsoft developed to increase usability 
for multifaceted software applications. Microsoft invested more than three 
years of research and development and millions of dollars in the new user 
interface design. They analyzed over 3 billion data sessions collected from 
Microsoft Office software users; conducted surveys and usability studies; 
built hundreds of conceptual prototypes; and experimented with new 
designs through customer site deployments and beta programs. The goal 
was to develop a new interface that would be easy to use, save time, and 
help users access all functionality.

The Microsoft Office Fluent user interface establishes a new way of 
working with comprehensive software products. It organizes tools, uses 
contextualization to simplify the number of choices available at any given 
time, and provides a scalable platform to build on for the future. BAE 
Systems recognized that this flexible interface could offer accelerated 
product creation for its image analysis, geospatial production, and mapping 
software customers. Subsequently, the company moved forward to include 
the new user interface in SOCET GXP v3.0.

SOCET GXP v3.0 is the first commercial, end-to-end geospatial information 
management application to implement the Microsoft Office Fluent user 
interface. Users who have tested the new software like the increased 
flexibility to customize the workspace for many different tasks, and to 
access SOCET GXP’s unprecedented range of powerful tools.

As an early adopter of this advanced technology, BAE Systems has built a 
ground-breaking software package with important discriminators in terms 
of functionality and efficiency. It is a notable accomplishment that is likely 
to transform the way the GIS and geospatial-intelligence communities 
manage data. Furthermore, it achieves BAE Systems’ vision of developing 
one intuitive application for image analysis (IA) and geospatial analysis 
(GA) that is easy to learn and use. By consolidating multiple IA and GA 
tasks into one system, BAE Systems has created a versatile geospatial-
intelligence tool for users and decision makers at all levels.

Today, most of the software Microsoft develops includes the new user 
interface, and a number of other companies have adopted it for their 
applications. Thus, the Microsoft Office Fluent user interface is well on its 
way to becoming the standard user interface for large-scale applications.
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The SOCET GXP v3.0 Multiport image viewing and 
exploitation window shown with the new Ribbon     
user interface.



The Ribbon
The main component of the new user interface is called the Ribbon. The 
Ribbon replaces a traditional menu and toolbar system and organizes tools 
by tabs that correspond to each task. The tools on each tab are grouped by 
function, and many of the tools are labeled to make them easy to identify.
The Ribbon stretches across the top of the Multiport viewing window and 
includes the following components:

Tabs−−  are designed to be task-oriented. The Home tab contains basic 
commands for using the application. Other tabs are organized by task.

Groups−−  within each tab break a task into subtasks. Each group contains 
a set of related commands that support the selected tab and tasks.

Commands−−  within each group are represented by controls such as 
buttons, sliders, and combo boxes. The controls work the same as in 
earlier versions of SOCET GXP.

Contextual tabs
To maintain an organized workspace, some tabs are contextual and appear 
only when relevant to the current task. For example, the Graphic Tools tab, 
which contains commands for changing a graphic’s color, line style, or fill 
pattern, appears when a graphic is selected. If a graphic is not selected, 
these commands are not available on the Ribbon. Contextual tabs are 
designed to alert the user to available functionality when needed.

Contextual tabs are a different color to make them 
easy to identify when they appear.
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Dialog Launchers
Some groups on the Ribbon include a small icon in the bottom right corner 
called a Dialog Launcher. A Dialog Launcher provides additional options or 
advanced functionality related to that group.

For example, to draw a graphic, the user selects the Shapes group on the Draw 
tab. All graphics associated with drawing shapes are located in this group. If 
the desired shape is not displayed, the user can click the Dialog Launcher to 
see the full set of shapes available in the Drawing Toolbox.

Scalability
The Ribbon scales up or down, depending on the size of the Multiport 
window, to accommodate laptop computers and desktop systems with 
multiple 30-inch monitors. If the window is wide, the Ribbon uses the extra 
space by labeling commands and replacing small icons with large icons. If 
the window is smaller, the Ribbon packs more information into less space 
by hiding labels, replacing large icons with small ones, and consolidating 
functional groups into a single icon with a drop-down menu.

No matter how large or small the Multiport window is, the Ribbon height 
never varies. When a user resizes a window, all of the commands on the 
Ribbon remain in the same relative position. This makes it easy to find and 
select commands.

Minimizing the Ribbon
Users working on a small screen, or who wish to minimize the footprint of 
the user interface and maximize the workspace viewing area, can do so by 
minimizing the Ribbon.

To minimize the Ribbon:

Double-click the selected tab, or−−

Right-click and select the −− Minimize the Ribbon option, or 

Press CTRL+F1 on the keyboard.−−

To restore the Ribbon to full size:

Double-click a tab again to restore the Ribbon.−−

To access the Ribbon while it is minimized, the user clicks the tab where 
the desired command is located. The Ribbon appears temporarily, allowing 
the user to select the command, and then returns to its minimized state.

Note: It is possible to use the keyboard to navigate the Ribbon while the 
Ribbon is minimized. For more information, see Using the Keyboard to Work 
with the Ribbon.

The Dialog Launcher icon provides access to 
additional options related to the functional group on 
which it is located.

Dialog Launcher icon

The Ribbon scales to accommodate screen size; 
on smaller displays space is economized by hiding 
labels, replacing large icons with small ones, and 
consolidating functional groups.
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The SOCET GXP button and menu
The SOCET GXP button is the round button with the SOCET GXP logo on it, 
located in the upper-left corner of the Ribbon. It replaces the File menu, 
and groups all of the file-level commands in one central place, making it 
easy to access these features.

When the user clicks the SOCET GXP button, the SOCET GXP button menu 
appears with two panels. The left panel has commands for opening, saving, 
and printing data. The right panel displays further options related to the 
selected command.

The SOCET GXP button is the access point for all file-
level commands, such as Open, Save, and Print.
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Quick Access Toolbar
The Quick Access Toolbar is a toolbar that the user can customize to 
display the commands used most often in a particular workflow. Commands 
on the Quick Access Toolbar are always visible and available, regardless of 
which tab is currently displayed.

To add a command to the Quick Access Toolbar:

On the Ribbon, click the tab that contains the command to add to the 1.	
Quick Access Toolbar.

Right-click on the command to add, then select 2.	 Add to Quick Access 
Toolbar on the shortcut menu. 

Note: Any command on the Ribbon can be added to the Quick Access Toolbar, 
including Dialog Launchers and commands on the SOCET GXP Button menu, 
such as Save and Print. The user can also add drop-down menus, sliders, 
combo boxes, and spin boxes. The only items that cannot be added to the 
Quick Access Toolbar are the individual options in a drop-down menu or 
combo box. In this instance, the user should add the command for the entire 
drop-down menu or combo box.

The Quick Access Toolbar can be located in one of two places.

The upper left corner of the Ribbon, next to the SOCET GXP Button; this  −−
is the default setting.

Below the Ribbon, if more room is needed for commands. Displaying    −−
the Quick Access Toolbar in this location reduces the viewable area in  
the Multiport.

To change the location of the Quick Access Toolbar:

Right-click on the Ribbon, or click the 1.	 Customize Quick Access Toolbar 
button on the right end of the Quick Access Toolbar.

Select 2.	 Show Quick Access Toolbar Below the Ribbon or Show Quick 
Access Toolbar Above the Ribbon from the list.

After adding a number of commands to the Quick Access Toolbar, the user 
may decide to improve its organization. 

To rearrange the contents of the Quick Access Toolbar:

Right-click on the Ribbon, or click the 1.	 Customize Quick Access Toolbar 
button on the right end of the Quick Access Toolbar.

From the menu, select the 2.	 Customize Quick Access Toolbar option. 
This displays the Customize Quick Access Toolbar window, which  
allows the user to rearrange the order of commands on the Quick 
Access Toolbar, add separators between commands, and remove 
unwanted commands.

The Customize Quick Access Toolbar window allows 
the user to rearrange the order of commands on 
the Quick Access Toolbar, add separators between 
commands, and remove unwanted commands.

The Quick Access Toolbar can be displayed either 
above or below the Ribbon.
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The Mini Toolbar
The Mini Toolbar is a small, floating toolbar that improves efficiency for 
mouse-oriented users by providing fast and convenient access to commonly 
used commands. The Mini Toolbar automatically appears when working with 
certain objects, and displays commands that are contextually relevant to 
the selected object. One of the benefits of the Mini Toolbar is that all tools 
needed for the current workflow are quickly accessible from one tab. 

After a graphic is selected, the Mini Toolbar appears as a small, semi-
transparent toolbar. Users can also access the Mini Toolbar by right-clicking 
on a graphic. When moving the cursor toward the Mini Toolbar, it darkens 
to full opacity; when moving the cursor away from the Mini Toolbar, it fades 
away. 

The Mini Toolbar is easy to hide when it is not needed. There is also a 
preference to turn off the Mini Toolbar so it does not appear when a graphic 
is selected.

In SOCET GXP v3.0, the Mini Toolbar is available for the active panel. If the 
user right-clicks the active panel, a contextual menu appears with a Mini 
Toolbar that contains commonly used commands such as pan, zoom, and 
rotate. The user does not have to switch back and forth between tabs to 
access commands, add them to the Quick Access Toolbar, or clutter the 
Quick Access Toolbar with unnecessary commands.

Note: The contents of the Mini Toolbar are determined by context and cannot 
be customized.
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Using the keyboard with the Ribbon
If the user prefers to use the keyboard instead of a mouse, the Ribbon 
provides two ways to access commands, Hot Keys, and KeyTips.

Keyboard shortcuts
Most of the keyboard shortcuts from earlier versions of SOCET GXP, also 
called Hot Keys, have been preserved. SOCET GXP v3.0 enables the user 
to customize keyboard shortcuts by selecting Tools > Customize Hot Keys 
from the Workspace Manager menu.

Pressing the ALT or F10 key displays KeyTips for all of 
the features available in the current view.

KeyTips
The Ribbon provides a feature called KeyTips that allows users to access 
any command in a few keystrokes. Most commands are accessible by 
using two-to-four keystrokes.

For example, to turn Terrain Tracking on and off using only the keyboard:

Press the ALT or F10 key to display KeyTips for all of the high-level 1.	
Ribbon elements, the SOCET GXP Button, Quick Access Toolbar 
commands, and tabs. Note the letters that appear below each element 
— these are the KeyTips.

Press the letter shown in the KeyTip to access a feature. Depending on 2.	
the feature, additional KeyTips may be shown. 

The user can continue to press letters until the desired command is 3.	
selected. 

For example, a user can press the G key to access the Geospatial tab, 
where Terrain Tracking is located. The Geospatial tab also displays the 
KeyTips for the commands found there. Then the user can press the T key 
and then the O key to turn Terrain Tracking on and off.

Note: If an incorrect key is pressed, pressing ESC once reverts to the 
previous step; pressing ESC multiple times reverts back multiple steps. 
Pressing the ALT key cancels the operation and hides the KeyTips.

Alternatively, after pressing and releasing the ALT or F10 key, the user can 
press the arrow keys to navigate the Ribbon. With the arrow keys, the user 
can move up, down, left, or right among the items on the Ribbon. The arrow 
keys move the focus among tabs and commands; the item that currently 
has focus is highlighted. Once the focus is on the desired command, the 
user can activate it by pressing the SPACEBAR or ENTER key.
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Conclusion
One of the goals of SOCET GXP v3.0 is to help users do their jobs more 
effectively. The new user interface, based on the Microsoft Office Fluent 
user interface design, organizes tools in a way that is intuitive and easy to 
learn. The Ribbon displays tools when needed, and hides them if they are 
not relevant to the current task. There are many new features that help 
users navigate the application. For example, the Quick Access Toolbar and 
Mini Toolbars make command access quick and efficient for mouse users, 
while KeyTips allow keyboard users to locate commands with a minimum of 
keystrokes. As a result, individuals and organizations can take advantage 
of the increased flexibility SOCET GXP offers for task-based workflows, 
application preferences, and streamlined access to information.

With the implementation of the new user interface and pushbutton processes 
that are available for the first time, BAE Systems continues its legacy as a 
technology innovator. As a result, SOCET GXP is becoming the tool of choice 
among mapping professionals, image analysts, geospatial analysts, and 
photogrammetrists.
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